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2 Customer Notification  

DISCLAIMER

The related documents in this customer notification may include preliminary versions. However, 
preliminary versions may not have been marked as such. 

The information in this customer notification is current as of its date of publication. The information is 
subject to change without notice. For actual design-in, refer to the latest publications of NEC’s data 
sheets or data books, etc., for the most up-to-date specifications of NEC PRODUCT(S). Not all 
PRODUCT(S) and/or types are available in every country. Please check with an NEC sales 
representative for availability and additional information. 

No part of this customer notification may be copied or reproduced in any form or by any means without 
prior written consent of NEC. NEC assumes no responsibility for any errors that may appear in this 
customer notification. NEC does not assume any liability for infringement of patents, copyrights or other 
intellectual property rights of third parties by or arising from the use of NEC PRODUCT(S) listed in this 
customer notification or any other liability arising from the use of such PRODUCT(S). 

No license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual 
property rights of NEC or others. Descriptions of circuits, software and other related information in this 
customer notification are provided for illustrative purposes of PRODUCT(S) operation and/or application 
examples only. The incorporation of these circuits, software and information in the design of customer’s 
equipment shall be done under the full responsibility of customer. NEC assumes no responsibility for any 
losses incurred by customers or third parties arising from the use of these circuits, software and 
information. 

While wherever feasible, NEC endeavors to enhance the quality, reliability and safe operation of 
PRODUCT(S) the customer agree and acknowledge that the possibility of defects and/or erroneous 
thereof cannot be eliminated entirely. To minimize risks of damage to property or injury (including death) 
to persons arising from defects and/or errors in PRODUCT(S) the customer must incorporate sufficient 
safety measures in their design, such as redundancy, fire-containment and anti-failure features.  

The customer agrees to indemnify NEC against and hold NEC harmless from any and all consequences 
of any and all claims, suits, actions or demands asserted against NEC made by a third party for damages 
caused by one or more of the items listed in the enclosed table of content of this customer notification for 
PRODUCT(S) supplied after the date of publication.  

Applicable Law: 

The law of the Federal Republic of Germany applies to all information provided by NEC to the Customer 
under this Operating Precaution document without the possibility of recourse to the Conflicts Law or the law 
of 5th July 1989 relating to the UN Convention on Contracts for the International Sale of Goods (the Vienna 
CISG agreement). 

Düsseldorf is the court of jurisdiction for all legal disputes arising directly or indirectly from this information. 
NEC is also entitled to make a claim against the Customer at his general court of jurisdiction. 

If the supplied goods/information are subject to German, European and/or North American export controls, 
the Customer shall comply with the relevant export control regulations in the event that the goods are 
exported and/or re-exported. If deliveries are exported without payment of duty at the request of the 
Customer, the Customer accepts liability for any subsequent customs administration claims with respect 
to NEC. 

Notes : (1) “NEC” as used in this statement means NEC Electronics and also includes its direct 
or indirect owned or controlled subsidiaries. 

(2) “PRODUCT(S)” means ‘NEC semiconductor products’ (NEC semiconductor products 
means any semiconductor product developed or manufactured by or for NEC) and/or 
‘TOOLS’ (TOOLS means ‘hardware and/or software development tools’ for NEC 
semiconductor products’ developed, manufactured and supplied by ‘NEC’ and/or 
‘hardware and/or software development tools’ supplied by NEC but developed and/or 
manufactured by independent 3rd Party vendors worldwide as their own product or on 
contract from NEC) 
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(A)� Changes from Version V2.40 to V2.52 

(1)� Windows XP is now supported. 
 
(2)� Windows 95 is no longer supported in V2.52 or later. 
 
(3)� Modification of ’right-mouse-click’ menu. 
 
(4)� The display file save/restore function has been separated into a display file and an environment file. 
 
(5)� The start frame of a function in the trace window has been changed to improve the display. 
 
(6)� Improvement of variable display selection. 
 
(7)� The Help menu has been changed to HTML-format help. 
 

(B)� Cautions on Installation 

(1)� A product ID is required to install SM78K0 V2.52. The product ID is shown on the medium case. 
 
(2)� Because is may necessary to restart the computer after installation, terminate all other applications. 
 
(3)� Administrator rights are required for installation in Windows NT, Windows 2000, or Windows XP. 
 
(4)� Do not install the tool in directory with a name containing a space or a multi-byte character; otherwise the 

tool may not be correctly executed. 
 
(5)� To re-install the SM78K0 V2.52, uninstall the copy of SM78K0 V2.52 already installed. If the product is 

installed in a different directory without uninstalling the first copy of SM78K0 V2.52, the first copy of 
SM78K0 V2.52 cannot be uninstalled. 

 
(6)� The following directory will be created during the installation. The content of the directory is necessary for 

uninstalling the tool and must not be deleted:  C:\NECTools32\SETUP\ 
(The installation destination is assumed to be C:\NECTools32.) 
 

(7)� The help is supplied in HTML help format If the help does not operate correctly, proceed as follows: 
Install Microsoft Internet Explorer 5.0 or later (IE5.5 SP2 or later recommended) 
 

(8)� The font setting in the Internet Explorer affects the font size of the help menu. If the display is too large in 
the default size ("Medium") of the Internet Explorer, change the font size to "Smallest" in [Fonts] from the 
[View] menu and restart the online help. 
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(C)� General Cautions (Debugger Block) 

 
(1)� The cursor in the ASCII display area does not follow changes in the display address on the memory 

window 
 
(2)� When the SFR names in several lines are selected in the SFR Select dialog box, the order of the 

selected SFR names cannot be changed. As a workaround select the lines one by one and change the 
SFR display order. 

 
(3)� Up to 10,000 lines can be displayed in the Watch window. If number exceeds 10,000 an error message 

will be displayed. 
 
(4)� Up to 65535 lines can be displayed in a C Source file. If the number exceeds 65535, please divide the 

source file. 
 
(5)� If an application is switched for any reason while an event icon is being dragged, the icon cannot be 

dropped. In such a case, release the drag status using the ESC key. 
 

(D)� General Cautions (Simulator Block) 

(1)� The Input Timing Chart Editor window and the 0/1 Editor Window can only be expanded up to a 
horizontal width of 1040 dots because the buffer size is limited. 

 
(2)� If the screen in which ANI pins are displayed at the beginning is set on the input timing chart or the 

output timing chart, the pins set as #47 and #48 may or may not displayed depending on the size. They 
are correctly displayed if the screen is re-sized. 

 
(3)� Only the representative interrupt name of interrupts having the same vectored interrupt address is 

displayed on the Interrupt drop down list of the SFR Event & Action setting window or Output Timing 
Chart window. 

 
(4)� Do not use the data search function of the Input 170 editor and the I/O Timing Chart because its search 

performance is poor. 
 
(5)� Even if a customized component is moved to the I/O panel window, it is displayed at the position before it 

was moved if it is subsequently reloaded by the project file or the custom menu of the I/O panel 
 
(6)� The interrupt name selection list of the internal interrupt button displays only the representative interrupt 

names of the interrupts having the same vector address. 
 
(7)� If a scroll-bar level gauge is connected to two or more AD pins or if these pins are reconnected to a dial 

level gauge or vice versa, the array of level gauges change/overlap then. 
 
(8)� The default value of a pin when a button is connected is ’0’ for both the active-high and the active-low 

models. As a workaround set Hi -> 0 and Lo -> 1 using the pull-up/pull-down function of an external part. 
 
(9)� When using Windows 2000, if right mouse button is clicked once to fix a level gauge value of the external 

parts, the value is not fixed but a pull-down menu is displayed. But the value will still be set. 
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(E)� Table of Operating Precautions (Debugger Block) 

 DSWIN-CDR-78K0 
8: Applicable 
9: Not applicable 
9 (*):

 Included in user’ manual 
- : Not checked 

No. Outline 

Version 2.11 2.30 2.40 2.52  

A1 
0DVN�YDOXH�FDQQRW�EH�VHW�LQ�WKH�(YHQW�GLDORJ�ER[� 8 9 9 9

A2 
A wrong error message is displayed in the 
Symbol to Address dialog box 

8 8 8 9
A3 

No error message is displayed in the Source 
Move dialog box, if an input value is illegal 

8 9 9 9
A4 Problem in trace search 8 9 9 9
A5 

Maximum address '0xFFFF' isn't displayed 
in Assembler window 

8 8 8 9 (*)
 

A6 'Coverage' on the [Option] menu stays valid 8 9 9 9
A7 

Pointer members cannot be displayed in 
Watch window 

8 8 8 9 (*)
 

A8 
Display problem in Source window if mixed 
mode is selected 

8 8 8 9 (*)
 

A9 
A part of the Status isn't displayed, if a 
screen-resolution less than 800X600 is used 

8 9 9 9
A10 

Memory Compare Result dialog box cannot 
be closed the return key 

8 9 9 9
A11 

Add Link Button enabled when Event Link 
dialog box is opened 

8 9 9 9
A12 

Error message is displayed twice during 
program execution 

8 9 9 9
A13 

Error message in illegal area is included in 
the Memory Compare Dialog Box 

8 9 9 9
A14 

No error message if old project file is 
ignored after loading 

8 9 9 9
A15 

Illegal data is saved, when display file is 
saved in Watch window 

8 9 9 9
A16 

Object file is loaded although it is specified 
to load only symbol information 

8 9 9 9
A17 

Character per line limitation in source 
window 

8 8 8 9 (*)
 

A18 
Breakpoint to the same address as the 
defined symbol value cannot be set 

8 8 8 9
A19 

Wrong display of pointer variable of type 
void 

8 9 9 9
A20 Error occurs if a load module is loaded again 8 9 9 9
A21 

The display may become illegible if the 
right/left arrow key is used for scrolling 

8 8 8 9
A22 

Breakpoints cannot be set in source files 
containing '-' or '+' in file name. 

8 8 8 8
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 DSWIN-CDR-78K0 
8: Applicable 
9: Not applicable 
9 (*):

 Included in user’ manual 
- : Not checked 

No. Outline 

Version 2.11 2.30 2.40 2.52  

A23 Abnormal debugger termination - 8 8 9
A24 

Last line of Coverage-Efficiency View dialog 
box is not displayed 

8 8 8 8
A25 

Search file function cannot be used in 
Source Search dialog box 

8 8 8 9
A26 

Display in Watch or Local Window of an 
array used as function argument is incorrect 

8 8 8 9

A27 
Files with same name, but located in 
different folders are not displayed in Source 
window 

8 8 8 9 (*)
 

A28 
Dummy real-time RAM monitor function is 
disabled in the SFR area 

8 8 8 9
A29 

Symbols in func#var format cannot be 
converted into addresses 

8 8 8 8

A30 
LMF file generated by IAR Systems tools 
and using only absolute segments cannot be 
read 

8 9 9 9
A31 Debugger doesn't stop 8 8 8 8
A32 

'*' display of EEPROM memory area at run-
time 

8 9 9 9
A33 

Bit-variables cannot be modified in Watch 
window 

8 9 8 9
A34 

Wrong display of Bit-variables in Watch 
window  

8 8 8 8
A35 

Source line information of assembler module 
missing 

8 8 8 8
A36 Read-only project file can be overwritten - - 8 8
A37 

Help does not open in Trace Window if F1 
key is pressed 

- - 8 8
A38 Problem in changing file type to ".hex"  - - 8 8
A39 Problem in Redraw - - 8 8
A40 

Modification of address of a label to be 
snapped in not reflected in the snapshot 
execution  

- - 8 8

A41 
Asterisk (*) indicating a break-settable line is 
not displayed in source window 

- - 8 9
A42 

Problem in saving a display file in watch 
window 

- - 8 9
A43 

Source Window doesn’t open automatically 
or Source Window is empty 

- 9 9 8
A44 

Wrong Warning Message after download of 
LNK-file or opening of a project file 

- 9 9 8
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DSWIN-CDR-78K0 
8: Applicable 
9: Not applicable 
9 (*):

 Included in user’ manual 
- : Not checked 

No. Outline 

Version 2.11 2.30 2.40 2.52  

A45 
Problem while single stepping into function 
called via function pointer 

- - 8 8
A46 

Single step problem with IAR Systems some 
library functions 

- - 8 8
A47 

Display problem in second Source Window if 
C- code is included  

- - 8 8
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(F)� Table of Operating Precautions (Simulator Block) 

 DSWIN-CDR-78K0 
8: Applicable 
9: Not applicable 
9 (*):

 Included in user’ manual 
- : Not checked 

No. Outline 

Version 2.11 2.30 2.40 2.52  

B1 
7KH�GDWD�FUHDWLRQ�IXQFWLRQ�RI�WKH�LQSXW�����HGLWRU�DQG�LQSXW�WLPLQJ�FKDUW�LVQ¶W�VXSSRUWHG� 8 8 8 9 (*)

 

B2 IIC arbitration function not supported 8 8 8 8
B3 

Key return function not supported  
(µPD780831, µPD780833) 

8 9 9 9
B4 

Bit shift detection function of SIO1 (3-
wire,auto. transfer function) not supported 

8 8 8 8
B5 

1-bit shift of output function of meter 
controller not supported 

8 8 8 8
B6 IEBUS function not supported 8 8 8 8
B7 

Oscillation clock selection function by SFR is 
not supported (µPD78035x/034x Sub-
series) 

8 8 8 8
B8 ROM correction function not supported 8 8 8 8
B9 

TAB key operation doesn't work in Event 
and Action dialog box 

8 8 8 9 (*)
 

B10 
SFR name in Event & Action dialog box 
differs from the actual device 

8 9 9 9
B11 Interrupt is not displayed in timing chart 8 8 8 8
B12 Wrong ADCR0, ADCR1 access 8 8 8 8
B13 

The time of the timer operating with the 
subclock may be wrong 

8 8 8 8
B14 Segment displayed in FIP0 is shifted 8 9 9 9
B15 

Scroll bar is not displayed in I/O Panel 
window 

8 8 8 8
B16 

Scroll bar is not displayed in Key Matrix Pin 
dialog box 

8 9 9 9
B17 

Problem in system menu of I/O Panel 
window (only Windows NT) 

8 8 8 8
B18 

I/O panel can not be restored after 
minimizing it  

8 8 8 8
B19 

Key return interrupt does not occur 
(µPD78003x/002x/083x Sub-series) 

8 9 9 9
B20 Error message when trace size is changed 8 9 9 9
B21 

Set value for level gauge cannot be input 
immediately after reset 

8 9 9 9
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DSWIN-CDR-78K0 
8: Applicable 
9: Not applicable 
9 (*):

 Included in user’ manual 
- : Not checked 

No. Outline 

Version 2.11 2.30 2.40 2.52  

B22 
Output from port 4 is not possible 
(only µPD7801x/00x/000x/05x/005x/07x and 
7809x Sub-series) 

8 9 9 9

B23 
Simulator inadvertently loops due to real-
time monitor function 

8 9 9 9
B24 

Real-time RAM monitor does not function 
after reading a project file 

8 9 9 9
B25 

Error message at step execution of infinite 
loop 

8 9 9 9
B26 

Input of port P5 and P6 does not operate 
(µPD780233) 

8 9 9 9
B27 

Trace information of SET1 and CLR1 
instruction missing 

8 9 9 9

B28 
Watch Timer interrupt does not occur 
(µPD78000x/005x/00x/01x/020x/02x/04x/05
x/06x/07x/08x and 09x Sub-series) 

8 9 9 9
B29 LIN Function of UART6 is not supported - - 8 8
B30 Ring-OSC clock not supported - - 8 8
B31 Clock monitor not supported - - 8 8
B32 Power-on clear not supported - - 8 8
B33 

Low-voltage detection circuit (LVI) not 
supported - - 8 8

B34 
Incorrect hold time of I/O panel button / key 
matrix - - 8 9

B35 
Illegal interrupt in serial interface CSIA0 
(µPD780148 Subseries) - - 8 9

B36 
Illegal interrupt in 8-bit timer TMH1 
(µPD780114, µPD780124, µPD780138, 
µPD780148 Subseries) 

- - 8 9

B37 
P14 cannot be used as output port 
(µPD780103, µPD780114, µPD780124, 
µPD780138, µPD780148 Subseries) 

- - 8 9
B38 Inverted output is not possible in UART6 - - 8 9
B39 

Waveform is distorted when TM34 is used in 
carrier generator mode - - 8 9

B40 
High level is output from pin when UART0 
operation is stopped - - 8 9

B41 
On-chip pull-up resistor cannot be 
connected to P4 (µPD780138, µPD780148 
Subseries) 

- - 8 9
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 DSWIN-CDR-78K0 
8: Applicable 
9: Not applicable 
9 (*):

 Included in user’ manual 
- : Not checked 

No. Outline 

Version 2.11 2.30 2.40 2.52  

B42 

Read-only bit NRZ1 of TMCYC1 register of 
8-bit timer TMH1 can be written 
(µPD780114, µPD780124, µPD780138, 
µPD780148 Subseries) 

- - 8 9
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(G)�Description of Operating Precautions (Debugger Block) 

No. A1 0DVN�YDOXH�FDQQRW�EH�VHW�LQ�WKH�(YHQW�GLDORJ�ER[ 

Details
A mask value cannot be set in a specified range of the address setting area in the Event dialog 
box. Even if a mask value is set, however, no error or warning message is displayed. An event is 
set ignoring the mask 
 
Workaround(s)

• - none-�

No. A2 A wrong error message is displayed in the Symbol to Address dialog box 

Details
If an SFR bit is specified in the Symbol to Address dialog box, a wrong error message is 
displayed: "F002(f), illegal expression". 
 
Workaround(s)

• Check the address of an SFR bit a map file 
 
Comment(s):

• Regard this as usage restriction.�

No. A3 No error message is displayed in the Source Move dialog box, if an input value is illegal 

Details
If the numeric value of a line number in the Source Move Dialog Box is illegal or omitted, no error 
message is displayed and the cursor moves to the first line. In addition, even if the line number is 
greater than the file line number, neither an error message is displayed nor does the cursor move. 
 
Workaround(s)

• - none-�
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No. A4 Problem in trace search 

Details
If the cursor is placed after the end frame and the rest of a specified range is searched forward 
during a trace search, the trace result is not searched from the end frame, but an error message is 
displayed. Similarly, if the cursor is placed before the first frame and the rest of the specified range 
is searched backwards an error message is displayed: "F003(W): Already exceed search region" 
 
Workaround(s)

• Place cursor within the search range�

No. A5 Maximum address ’0xFFFF’ isn’t displayed in Assembler window 

Details
The maximum address ’0xFFFF’ of the Assemble window is not displayed 
 
Workaround(s)

• - none-�
Comment(s):

• This is no problem because ’0xFFFF’ is in the SFR area. Regard this as usage restriction.�

No. A6 ’Coverage’ on the [Option] menu stays valid 

Details
‘Coverage’ on the [Option] menu stays valid even during program execution. Nothing can be set 
even if selected. 
 
Workaround(s)

• - none-�
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No. A7 Pointer members cannot be displayed in Watch window 

Details
Even if the members of pointers such as structures and arrays are displayed and saved to the 
project file, the members are not displayed in the Watch window when the project file is loaded. At 
this time, the display radix of each member is not displayed. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A8 Display problem in Source window if mixed mode is selected 

Details
If mixed display mode is selected for the Source window at the cursor is scrolled downward a 
redundant scroll occurs. As a result, the displayed line numbers may not be sequential. While the 
end of the source file is displayed, the last part cannot be displayed unless scroll is used during 
mixed display 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A9 A part of the Status isn’t displayed, if a screen-resolution less than 800X600 is used 

Details
A part of the Status line is not displayed, if a screen resolution less 800x600 pixel is used 
 
Workaround(s)

• - none-�
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No. A10 Memory Compare Result dialog box cannot be closed the return key 

Details
The Memory Compare Result dialog box cannot be closed with the return key even if the default 
button is ’Close’ 
 
Workaround(s)

• Close the dialog box using the mouse�

No. A11 Add Link Button enabled when Event Link dialog box is opened 

Details
The Add Link button is disabled when the Trace dialog box is opened, but enabled when the 
Event Link dialog box is opened. But the Add Link button should be disabled, because an event 
link cannot be used in the Trace dialog box 
 
Workaround(s)

• - none-�

No. A12 Error message is displayed twice during program execution 

Details
If the Timer dialog boy is opened during program execution, the error message ’0302(F): User 
program is being traced’ is displayed twice 
 
Workaround(s)

• Read the message as  ’User program is running’ 
 

No. A13 Error message in illegal area is included in the Memory Compare Dialog Box 

Details
If an illegal area (guard area or area that cannot be mapped) is included in the comparison source 
address range or destination address range in the Memory Compare dialog box, the error 
message ’F201(f), Memory mapping error’ is displayed. If the OK button is clicked, the Memory 
Compare dialog box disappears. 
 
Workaround(s)

• Do not include an illegal area�
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No. A14 No error message if old project file is ignored after loading 

Details
If a project file created with SM78K0 V2.10 or earlier is loaded, no error message is displayed am 
the file is ignored. 
 
Workaround(s)

• Create a new project file with version V2.10.�

No. A15 Illegal data is saved, when display file is saved in Watch window 

Details
When the display content of the Watch Window is saved to a file, the variable values that are not 
displayed in the window will be save incorrectly 
 
Workaround(s)

• Before saving the display file, scroll the Watch window and display all the variables in the 
window once.�

No. A16 Object file is loaded although it is specified to load only symbol information 

Details
The object is also loaded if an Intel-HEX file is specified and it is specified to load only symbol 
information in the Download dialog box. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A17 Character per line limitation in source window 

Details
The number of characters that can be used per line in the Source window, Assemble or watch-
related windows is up to 319 (199 in V2.11). The 320th (200th in V2.11) an subsequent characters 
are not displayed 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�
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No. A18 Breakpoint to the same address as the defined symbol value cannot be set 

Details
If valid EQU symbols are defined only in an assembler source file, a breakpoint to the same 
address as the defined symbol cannot be set 
 
Workaround(s)

• Define EQU symbols in a header file so that all the assembler source files can reference 
them. �

Comment(s):
• Regard this as usage restriction.�

No. A19 Wrong display of pointer variable of type void 

Details
A pointer variable value of type void cannot be displayed correctly in the Variable Window 
 
Workaround(s)

• - none-�

No. A20 Error occurs if a load module is loaded again 

Details
An error occurs if a load module that is read by a project file is downloaded again from the file list 
on the [File] menu immediately after the project is read 
 
Workaround(s)

• Reading a project file downloads a load module. To read the load module again either use 
the [File] -> [Download] menu or read the same project file again.�
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No. A21 The display may become illegible if the right/left arrow key is used for scrolling 

Details
When there is insufficient space in the data value display setting area (in the SFR or Register 
window, etc.) and the right/left arrow key is used to scroll the area, the display in the data value 
display/setting area may become illegible. 
 
Workaround(s)

• Expand the size of the window before operating.�
Comment(s):

• Regard this as usage restriction.�

No. A22 Breakpoints cannot be set in source files containing ’-’ or ’+’ in file name. 

Details
If a source file name includes a ’-’ (minus) or a ’+’ (plus), a break point cannot be set in the 
debugger. 
 
Workaround(s)

• Change the file name so that it does not include a ’-’ (minus) or a ’+’ (plus).�
Comment(s):

• Regard this as usage restriction.�

No. A23 Abnormal debugger termination 

Details
If there is a script file with the same name as the load module to be downloaded and with the 
extension ’.tcl’, the script will be automatically executed immediately before the download. If the 
program to download the load module is written in a script, the download loops an the debugger  
is abnormally terminated 
 
Workaround(s)
Change the script file to one that does not have the same name as the load module file name, if 
the script should not automatically be executed immediately before the download. In addition, do 
not write the instruction to download the load module to the script file that should automatically be 
executed immediately before the download. 

 
Comment(s):

• Regard this as usage restriction.�
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No. A24 Last line of Coverage-Efficiency View dialog box is not displayed 

Details
The last line is not displayed in the Coverage-Efficiency View dialog box. The last line is hidden 
behind the horizontal scroll bar when an item consisting of 21 characters or more is included and 
the total number of items exceeds 12 in the survey list. 
 
Workaround(s)

• Add one ore more dummy items at the end of the list.�
Comment(s):

• Regard this as usage restriction.�

No. A25 Search file function cannot be used in Source Search dialog box 

Details
The search function cannot be used in the Source Search dialog box 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A26 Display in Watch or Local Window of an array used as function argument is incorrect 

Details
When an attempt is made to reference the contents of an array from the Watch or Local Window 
when an array is declared as function argument, the displayed memory location is incorrect. 
 
Workaround(s)

• When referencing an array variable as a function argument, do not declare the array as the 
argument. Instead declare a pointer and make a pointer access.�

Comment(s):
• Regard this as usage restriction.�
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No. A27 Files with same name, but located in different folders are not displayed in Source window 

Details
The source file in the folder set in the source path under [Option] -> [Debugger Option] is opened 
by priority in the Source Window. 
C:\TEST\TEST.C <- source file of C:\TEST\TEST.LMF 
C:\TEST\TEST.LMF 
 
D:\TEST\TEST.C <- source file of D:\TEST\TEST.LMF 
D:\TEST\TEST.LMF 
 
C:\TEST\ is set in the source path under [Option] -> [Debugger Option] 
At this time C:\TEST\TEST.LMF is displayed even if D:\TEST\TEST.LMF is opened from [File] -> 
[Download] menu. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A28 Dummy real-time RAM monitor function is disabled in the SFR area 

Details
Dummy real-time RAM monitor function is disabled in the SFR area. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A29 Symbols in func#var format cannot be converted into addresses 

Details
Symbols in func#var (func: function name, var: variable name) format cannot be converted into 
addresses 
 
Workaround(s)

• Convert the variable. When there is a variable with the same name as a static variable in a 
function, convert the variable when the program counter exists in that function.�

Comment(s):
• Regard this as usage restriction.�
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No. A30 LMF file generated by IAR Systems tools and using only absolute segments cannot be 
read 

Details
The LMF file generated by IAR Systems tools and using only absolute segments cannot be read. 
 
Workaround(s)

• Use relative segments and define the physical address in the linker control file.�

No. A31 Debugger doesn’t stop 

Details
When [Run] ->[Slowmotion] is selected while Go & Go is under execution, the program does not 
stop even if [Run] -> [Stop] is selected or the stop button is clicked. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. A32 ’*’ display of EEPROM memory area at run-time 

Details
’*’ (Asterisks) are displayed in the EEPROM memory area at run-time. 
 
Workaround(s)

• - none- 
 

No. A33 Bit-variables cannot be modified in Watch window 

Details
Bit-variables located in the address area 0xFEFC to 0xFEFF can’t be modified in the Watch 
window. 
 
Workaround(s)

• Modify the bit-variables in the Memory window 
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No. A34 Wrong display of Bit-variables in Watch window 

Details
Wrong display of Bit-variables in Watch window, if the bits are defined in an IAR Systems 
Assembler module. 
 
Workaround(s)

• Define the bits in a C Module and declare the bits as extern in the assembler module. 

No. A35 Source line information of assembler module missing 

Details
If two assembler modules are existing in one IAR assembler source file, some parts of the source 
line information for the second module is missing. Single step through the second module is 
possible, but a break point cannot be set (no * in the source lines). 

Workaround(s)
• Define only one assembler module in a source file. 

 
Comment(s):

• Regard this as usage restriction.�

No. A36 Read-only project file can be overwritten 

Details
Project Files (*.prj, *.pri) can be overwritten depending on the OS even if the file attribute is set to 
read-only. In Windows XP an error is displayed when attempting to overwrite the file, but the file 
can be overwritten in Windows 2000. 
 
Workaround(s)

• - none- 
 

No. A37 Help does not open in Trace Window if F1 key is pressed 

Details
The help window is not displayed when the F1 key is pressed while no trace result is displayed, 
such as immediately after the start of the debugger. This is because the help window can be 
opened by F1 key only in the window on which the caret is placed, and the caret cannot be moved 
if there are no trace results. 
 
Workaround(s)

• Open the help window by selecting [Current Window Help] under the Help menu. 
 



Operating Precautions for DSWIN-CDR-78K0 
 

Customer Notification  23 

 
No. A38 Problem in changing file type to ".hex" 

Details
Even if the display of the extension select area is changed by specifying the file type as "*.hex" in 
the file selection area in a file selection boy, the change is not reflected internally. 
 
Workaround(s)

• Specify the file type in the extension select area. 
 

No. A39 Problem in Redraw 

Details
If the caret is moved when the Memory window or Coverage window is activated, the line on 
which the caret was placed cannot be redraw normally. 
 
Workaround(s)

• Redraw can be performed by moving the caret to a line on which redraw was not 
performed. 

 
Comment(s):

• Regard this as usage restriction.�

No. A40 Modification of address of a label to be snapped in not reflected in the snapshot execution 

Details
When a label is specified for a memory address subject to snap in the Snap Shot dialog box, the 
address before modification is snapped, if the address of the registered label is changed in line 
with a user program modification. 
 
Workaround(s)

• When the address of the registered label is changed, re-register the snap information 
using the change button. 

 

No. A41 Asterisk (*) indicating a break-settable line is not displayed in Source window 

Details
An asterisk (*) indicating a break-settable line is not displayed in the Source window when only a 
macro (instruction) reference line is described in an include file and the line number is the same 
as the instruction start line in the file to be included. 
 
Workaround(s)
- none -  
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No. A42 Problem in saving a display file in watch window 

Details
If data is added to the Watch Window by specifying the address, the data cannot be saved 
correctly even if the display file saving command is executed. 

Workaround(s)
- none - 
 

No. A43 Source Window doesn’t open automatically or Source Window is empty 

Details
The source window doesn’t open automatically after a download of an LNK file or the source 
window is empty after the opening of a project file although the debugger option setting of the 
compiler and linker is correct.  

Workaround(s)
Modify the Begin- and End- Label of the Startup Module in the Debugger Option Window [menu 
Options-> Debugger Option ]. This setting is stored in the project file, so that this modification 
must be done only once. 
 

No. A44 Wrong Warning Message after download of LNK-file or opening of a project file 

Details
After the download of an LNK-file or the opening of a project file the following warning is 
displayed:      Wc01d: Selected load module different from kind(Chip) that was loaded 
This warning message is wrong and can be ignored. 
 
Workaround(s)
- none - 
 

No. A45 Problem while single stepping into function called via function pointer 

Details
If a function is called via function pointer the single step in doesn’t work correct, a step over is 
executed instead. 
 
Workaround(s)
Set a breakpoint at the beginning of the function to enter it. 
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No. A46 Single step problem with IAR Systems some library functions 

Details
The single step doesn’t work with some IAR Systems library functions (only compiler version 
V3.34b). The debugger doesn’t stop at the next instruction, but goes into run-mode and must be 
stopped manually. Existing breakpoints are ignored.  
 
The issue occurs at the following functions for stack-, wrkseg- operations, and switch statement: 
 
LOAD_A_SP_L06 STORE_A_SP_L06 LOAD_AX_SP_L06           
STORE_AX_SP_L06 LOAD_AXBC_SP_L06 STORE_AXBC_SP_L06          
XLOAD_A_SP_L06             XSTORE_A_SP_L06            XLOAD_AX_SP_L06            
?XSTORE_AX_SP_L06           XLOAD_AXBC_SP_L06          XSTORE_AXBC_SP_L06         
FUNC_ENTER_L06             FUNC_DEALL_L06             FUNC_LEAVE_L06             
MOVE_LONG_L06              IND_CALL_L06               POPB_L_L06                 
L_F_OPASG_L06              L_F_DEALLOC_L06            L_F_DEALLOC_STAT_L06       
 
WRKSEG_PUSH_L09            WRKSEG_POP_L09             
 
C_SSWITCH_L10              I_SSWITCH_L10              L_SSWITCH_L10              
C_VSWITCH_L10              I_VSWITCH_L10              
 
Workaround(s)
- none - 
 

No. A47 Display problem in second Source Window if C- code is included 

Details
If C code is included by the #include <name.c> the debug information for the included c-code may 
be invalid. This causes some display problems in a second (or higher) source window). 
 
Workaround(s)
- Open only one Source Window. 
- Don’t include C code, but use different source modules. 
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(H)� Description of Operating Precautions (Simulator Block) 

No. B1 7KH�GDWD�FUHDWLRQ�IXQFWLRQ�RI�WKH�LQSXW�����HGLWRU�DQG�LQSXW�WLPLQJ�FKDUW�LV�QRW�VXSSRUWHG 

Details7KH�GDWD�FUHDWLRQ�IXQFWLRQ�RI�WKH�LQSXW�����HGLWRU�DQG�LQSXW�WLPLQJ�FKDUW�LV�QRW�VXSSRUWHG 

Workaround(s)
• - none-�

Comment(s):
• Regard this as usage restriction.�

No. B2 IIC arbitration function not supported 

Details
The IIC arbitration function is not supported. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B3 Key return function not supported (µPD780831, µPD780833) 

Details
The key return function is not supported. 
 
Workaround(s)

• - none-�

No. B4 Bit shift detection function of SIO1 (3-wire,auto. transfer function) not supported 

Details
The bit shift detection function of SIO1 (3-wire, auto. transfer function) is not supported. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�
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No. B5 1-bit shift of output function of meter controller not supported 

Details
The 1-bit shift of output function of meter controller is not supported. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B6 IEBUS function not supported 

Details
The IEBUS function is not supported. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B7 Oscillation clock selection function by SFR n ot supported (µPD78035x/034x Sub-series) 

Details
The oscillation clock selection function by SFR is not supported (µPD78035x/034x Sub-series). 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B8 ROM correction function not supported 

Details
The ROM correction function is not supported. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�
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No. B9 TAB key operation doesn’t work in Event and Action dialog box 

Details
The function to jump to the next input field by pressing TAB key cannot be used in the Event and 
Action dialog box. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B10 SFR name in Event & Action dialog box differs from the actual device 

Details
The following SFR name in the Event & Action dialog box differs from the SFR name of the actual 
device. 
 Device name: µPD78097X 
 SFR name on Event & Action dialog box: SIO3, CSIM3 
 SFR name on actual device: SIO, CSIM 
 
Workaround(s)

• - none-�

No. B11 Interrupt is not displayed in timing chart 

Details
If an interrupt occurs from the interrupt controller peripheral unit when execution of one instruction 
has been completed, the interrupt signal information is not displayed on the timing chart. In 
addition, if two or more non-maskable interrupts having a separate vector address at the same 
time (multiple interrupts), only one interrupt can be acknowledged. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�
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No. B12 Wrong ADCR0, ADCR1 access 

Details
If conversion is completed by ADCLT0 while a read operation is being executed by the instruction 
of the ADCR0 register, the value of ADCR0 should be changed after reading ADCR0 according to 
the specifications. Actually, however, the updated value is read. If a write access to the ADCR0 
register, a write access to the ADM0 register by command and a write access to the ADS0 
register conflict with each other, the write access to the ADCR0 register is enabled if the 
conversion operation is enabled and an interrupt signal (INTAD) is generated. This behavior also 
applies to the ADS1 register. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B13 The time of the timer operating with the subclock may be wrong 

Details
The time of the timer operating with the subclock may be wrong: 
 Example:  <1> Specification: 500.0 ms, SM 498.0736ms 
 <1> Specification: 15.6 ms, SM 15.5652ms 
 

Workaround(s)
• - none-�

Comment(s):
• Regard this as usage restriction.�

No. B14 Segment displayed in FIP0 is shifted 

Details
The segment displayed in FIP0 is shifted. 
 
Workaround(s)

• - none-�
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No. B15 Scroll bar is not displayed in I/O Panel window 

Details
The scroll bar is not displayed in I/O Panel window, if a component is moved to the edge of the I/O 
panel in the layout mode or if a customized component for the I/O panel is too big to be displayed. 
 
Workaround(s)

• The scroll bar is displayed by re-sizing the I/O Panel window.�
Comment(s):

• Regard this as usage restriction.�

No. B16 Scroll bar is not displayed in Key Matrix Pin dialog box 

Details
The scroll bar is not displayed in the Key Matrix Pin dialog box.  
 
Workaround(s)

• Move the cursor after pin setting.�

No. B17 Problem in system menu of I/O Panel window (only Windows NT) 

Details
If the simulator is executed in Windows NT, the menu cannot be deleted or recovered using 
’Display Menu’ on the system menu of the I/O Panel window. 
 
Workaround(s)

• - none-�
Comment(s):

• Regard this as usage restriction.�

No. B18 I/O panel can not be restored after minimizing it 

Details
If the I/O Panel window is minimized in layout mode, it is not restored to its original size even if the 
icon on the taskbar is clicked. 
 
Workaround(s)

• Right-click the icon and select ’Restore’ from the system menu.�
Comment(s):

• Regard this as usage restriction.�



Operating Precautions for DSWIN-CDR-78K0 
 

Customer Notification  31 

 
No. B19 Key return interrupt does not occur   (µPD78003x/002x/083x Sub-series) 

Details
In the µPD78003x/002x and 083x Sub-series, the key interrupt does not occur if a key input is 
performed. 
 
Workaround(s)

• - none-�

No. B20 Error message when trace size is changed 

Details
When the trace size is changed to 3MB or more (varies depending on the PC resources) in the 
Extended Option dialog box, the error message 'e000(f): Illegal argument' is displayed and trace is 
turned OFF. 
 
Workaround(s)

• Increase the virtual memory size of the PC.�

No. B21 Set value for level gauge cannot be input immediately after reset 

Details
Even is a set value for the level gauge of the I/O Panel is input immediately after CPU reset, the 
value is not correctly reflected in the conversion result. 
 
Workaround(s)

• Set the value for the level gauge after executing one or more instructions following CPU �
reset�

No. B22 Output from port 4 is not possible (µPD7801x/00x/000x/05x/005x/07x and 7809x Sub-series) 

Details
In the µPD7801x/00x/000x/05x/005x/07x and 7809x Sub-series output from port 4 is not possible 
even if port mode setting register PM4 is set to output mode. 
 
Workaround(s)

• -none- 
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No. B23 Simulator inadvertently loops due to real-time monitor function 

Details
When a program is executed for a certain period while the Memory window or Watch window is 
open, the program may inadvertently loop or an illegal break may occur. In the case of loop, even 
if the program is stopped using the forced break the message ’User program is running’ may be 
displayed when the program is next executed. 
 
Workaround(s)

• -none- 
 

No. B24 Real-time RAM monitor does not function after reading a project file 

Details
The Real-time RAM monitor does not function after reading a project file even if the Memory 
window is displayed. 
 
Workaround(s)

• -none- 
 

No. B25 Error message at step execution of infinite loop 

Details
The error message ’e000(f): Illegal argument’ will be displayed when a step execution is 
performed on one line in for or while statement. 
In addition the error message’78018f): Cancelled step wait’ will also be displayed, but this is just a 
succession of the not terminated step execution within a certain time period, so it is not a Problem. 
 
Workaround(s)

• -none- 
 

No. B26 Input of port P5 and P6 does not operate (µPD780233) 

Details
When a value is externally input to port register P5 (PT5) and P6 (PT6) in the µPD780233 Sub-
series, only the value '0' is read. 
 
Workaround(s)

• Use another input port instead. 
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No. B27 Trace information of SET1 and CLR1 instruction missing 

Details
A memory write of the SET1 and CLR1 instructions is traced in the Trace window, but a memory 
read is not. 
 
Workaround(s)

• -none- 
 

No. B28 Watch Timer interrupt does not occur  
(µPD78000x/005x/00x/01x/020x/02x/04x/05x/06x/07x/08x and 09x Sub-series) 

Details
In µPD78000x/005x/00x/01x/020x/02x/04x/05x/06x/07x/08x and 09x Sub-series the Watch Timer 
interrupt (INTWT) does not occur when the watch timer is operated. 
 
Workaround(s)

• -none- 
 

No. B29 LIN function of UART6 is not supported 

Details
The LIN function of UART6 is not supported. 
 
Workaround(s)

• -none- 
 
Comment(s):

• Regard this as usage restriction. 
 

No. B30 Ring-OSC clock not supported  

Details
The Ring-OSC clock not supported and not supplied with the mounted macro. Therefore the 
operation when the RING-OSC is selected as a count clock is not guaranteed. 
 
Workaround(s)

• -none- 
 
Comment(s):

• Regard this as usage restriction.�
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No. B31 Clock monitor not supported 

Details
The clock monitor not supported. 
 
Workaround(s)

• -none- 
 
Comment(s):

• Regard this as usage restriction.�

No. B32 Power-on clear not supported 

Details
The Power-on clear function is not supported. 
 
Workaround(s)

• -none- 
 
Comment(s):

• Regard this as usage restriction.�

No. B33 Low-voltage detection circuit (LVI) not supported 

Details
The Low-voltage detection circuit (LVI) not supported. 
 
Workaround(s)

• -none- 
 
Comment(s):

• Regard this as usage restriction.�

No. B34 Incorrect hold time of I/O panel button / key matrix 

Details
When the main clock is changed in the Configuration dialog box after the simulator is activated, 
the hold time of the button / key matrix in the I/O panel is not simulated correctly. The old main 
clock is used for simulation. 
 
Workaround(s)

• -none- 
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No. B35 Illegal interrupt in serial interface CSIA0 (µPD780148 Subseries) 

Details
When using the µPD780148 Subseries, the interrupt INTACSI occurs each time the last byte is 
transmitted in repeat transfer mode of serial interface CSIA0. 
 
Workaround(s)

• -none- 
 

No. B36 Illegal interrupt in 8-bit timer TMH1  
(µPD780114, µPD780124, µPD780138, µPD780148 Subseries) 

Details
When the 8-bit timer TMH1 of µPD780114, µPD780124, µPD780138, or µPD780148 subseries is 
used in carrier generator mode, the interrupt INTTM51 is generated twice. 
 
Workaround(s)

• -none- 
 

No. B37 P14 cannot be used as output port  
(µPD780103, µPD780114, µPD780124, µPD780138, µPD780148 Subseries) 

Details
P14 cannot be used as output port in the µPD780103, µPD780114, µPD780124, µPD780138, or 
µPD780148 subseries. 
 
Workaround(s)

• -none- 
 

No. B38 Inverted output is not possible in UART6 

Details
Inverted output is not possible in UART6 even if the inverted output is specified for the TCD pin of 
UART6. 
 
Workaround(s)

• -none- 
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No. B39 Waveform is distorted when TM34 is used in carrier generator mode 

Details
When TM34 is used in carrier generator mode, a waveform may be distorted depending on the 
setting value of the operating clock. 
 
Workaround(s)

• -none- 
 

No. B40 High level is output from pin when UART0 operation is stopped 

Details
When UART0 is stopped, a high level is output from the pin. As a result, the pin cannot be used 
as a port pin. 
 
Workaround(s)

• -none- 
 

No. B41 On-chip pull-up resistor cannot be c onnected to P4 (µPD780138, µPD780148 Subseries) 

Details
An on-chip pull-up resistor cannot be connected to port P4 in the µPD780138, µPD780148 
subseries. 
 
Workaround(s)

• -none- 
 

No. B42 Read-only bit NRZ1 of TMCYC1 register of 8-bit timer TMH1 can be written  
(µPD780114, µPD780124, µPD780138, µPD780148 Subseries) 

Details
When using the µPD780114, µPD780124, µPD780138, or µPD780148 subseries, the read-only 
bit NRZ1 can be written when TMCYC1 register of 8-bit timer TMH1 is accessed in byte units. 
 
Workaround(s)

• -none- 
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(I)� List of Devices Supported by DSWIN-CDR-78K0 

The System Simulator for 78K0 devices does not support all device sub-series. The support status of each 
sub-series is shown below. 
 

DSWIN-CDR-78K0 9: supported 
 8: not supported Sub-series 

 
Version 2.11 2.30 2.40 2.52  

�3'������ 9 9 9 9
�3'������<� 8 8 8 8
�3'������ 9 9 9 9
�3'�����<� 9 9 9 9
�3'������� 9 9 9 9
�3'������$� 8 9 9 9
�3'������$6� 8 9 9 9
�3'������$<� 8 9 9 9
�3'������<� 9 9 9 9
�3'������� 9 9 9 9
�3'������$� 8 9 9 9
�3'������$6� 8 9 9 9
�3'������$<� 8 9 9 9
�3'������<� 9 9 9 9
�3'������� 9 9 9 9
�3'������<� 9 9 9 9
�3'������� 8 9 9 9
�3'������� 8 9 9 9
�3'������<� 8 9 9 9
�3'������� 8 8 9 9
�3'������� 8 8 9 9
�3'������� 8 8 9 9
�3'������� 8 8 9 9
�3'������� 8 8 9 9
�3'������ 9 9 9 9
�3'�����<� 9 9 9 9
�3'�����+� 9 9 9 9
�3'�����)� 9 9 9 9
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DSWIN-CDR-78K0 9: supported 
 8: not supported Sub-series 

 
Version 2.11 2.30 2.40 2.52  

�3'�����)<� 9 9 9 9
�3'������ 9 9 9 9
�3'������ 9 9 9 9
�3'����� 9 9 9 9
�3'������ 9 9 9 9
�3'������< 9 9 9 9
�3'������ 9 9 9 9
�3'������ 9 9 9 9
�3'������ 9 9 9 9
�3'������ 8 9 9 9
�3'������< 8 9 9 9
�3'������ 8 9 9 9
�3'������< 8 9 9 9
�3'����� 9 9 9 9
�3'�����$ 9 9 9 9
�3'�����% 9 9 9 9
�3'�����) 9 9 9 9
�3'�����+ 9 9 9 9
�3'������ 9 9 9 9
�3'����� 9 9 9 9
�3'�����< 9 9 9 9
�3'����� 9 9 9 9
�3'�����% 9 9 9 9
�3'�����< 9 9 9 9
�3'�����$ 9 9 9 9
�3'�����$< 9 9 9 9
�3'������< 8 8 8 8
�3'�����% 8 8 8 8
�3'����� 9 9 9 9
�3'�����< 9 9 9 9
�3'����� 9 9 9 9
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 DSWIN-CDR-78K0 9: supported 
 8: not supported Sub-series 

 
Version 2.11 2.30 2.40 2.52  

�3'������� 8 8 8 8
�3'������� 8 8 8 8
�3'������%� 8 8 8 8
�3'������< 9 9 9 9
�3'������< 9 9 9 9
�3'������ 8 8 8 8
�3'������ 9 9 9 9
�3'������ 8 8 8 8
�3'������� 8 8 8 8
�3'������ 9 9 9 9
�3'������ 9 9 9 9
�3'����� 9 9 9 9
�3'�����$ 8 9 9 9
�3'�����% 8 9 9 9
�3'������ 9 9 9 9
�3'��3���� 8 8 8 8
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(J)� Valid Specification 

Item Date published Document No. Document Title 

1 September 2003 U16768EJ1V0UM00 User’s Manual System Simulator 78K Series 

2 February 2002 U15802EJ1V0UM00 External Part User Open Interface Specification 

(K)� Revision History 

Item Date published Document No. Comment 

1 08-07-2002 DTOP0007V10 First release 

2 06-12-2002 DTOP0007V11 Update for Version 2.40 

3 21-11-2003 DTOP0007V12 Update for Version 2.52 

4 27-04-2004 DTOP0007V13 Item A45, A46,A47 added  


